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1. Managing Information in Table 

 

Spreadsheets are great for making lists (such as phone lists, client lists). The researchers discovered 

that not only was list management the number one spreadsheet activity, but also that a lot of users 

did nothing but create and maintain lists of various sorts. 

 

1.1 Building and Maintaining a Table 

When you create a table, you can manage and analyze the data in that table independently of data 

outside the table. For example, you can filter table columns, add a row for totals, apply table 

formatting, and publish a table to a server that is running SharePoint. 

If you do not want to work with your data in a table, you can convert the table to a regular range 

while keeping any table style formatting that you applied. When you no longer need a table, you 

can delete it. 

1. On a worksheet, select the range of cells that you want to include in the table. The cells can be 

empty or can contain data.  

2. On the Insert tab, in the Tables group, click Table. 

3. If the selected range contains data that you want to display as table headers, select the My 

table has headers check box. 

4. Table headers display default names if you do not select the My table has headers check box. 

You can change the default names by typing the text that you want.  
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2. Handle Duplicate Row  

 

2.1 Remove Duplicate 
Microsoft has made it quicker to remove duplicate rows in Excel, all it takes now is two simple 

steps. The best part is that you don’t need to select any specific row before removing the duplicate 

rows, the build-in Remove Duplicate feature takes care of it. 

1. Sort the record in ascending order 

2. Select the table, and then select Data Tab, then select Remove Duplicates 
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2.2 Highlight Duplicate  

1. Select the table column that you want to check for duplicate values. For example, you could 

select the Product ID column to look for products that have the same ID value. Note: You can 

highlight more than one column, but if you do, Excel highlights identical values that appear in 

more than one column. For example, if the same number appears in the Product ID column and 

in the Price column, Excel highlights it even though it isn't really a duplicate. 

2. Choose HomeStylesConditional FormattingHighlight Cells RulesDuplicate Values. 

 

3. When the Duplicate Values dialog box appears, choose the type of formatting you'd like to use 

to highlight repeated values. People often choose to change the background color. 

 

4. Click OK. Excel changes the background color of all values that appear more than once in the 

selected column. Conditional formatting keeps working even after you've applied it. So, if you 

add a new record that duplicates the value of an existing record in the column you're checking, 

Excel immediately highlights it. It's like having a duplicate value cop around at all times. 
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3. Filtering  

 

Filtering is a quick and easy way to find and work with a subset of data in a range. A filtered range 

displays only the rows that meet the criteria you specify for a column. Excel provides two 

commands for filtering ranges: AutoFilter and Advanced Filter. 

Unlike sorting, filtering does not rearrange a range. Filtering temporarily hides rows you do not 

want displayed. When Excel filters rows, you can edit, format, chart, and print your range subset 

without rearranging or moving it. 

 

3.1 Use AutoFilter for Simple Criteria and to Filter by Selection 

Using AutoFilter, you can create three types of filters: by a list values, by a format, or by criteria. 

Each of these filter types is mutually exclusive for each range of cells or column table. For example, 

you can filter by cell color or by a list of numbers, but not by both; you can filter by icon or by a 

custom filter, but not by both.  

 

3.1.1 Make sure the data type is the same in each column: 

In your worksheet, the top row of each column should have a heading that describes the contents of 

the column, such as "Product Number" or "Customer". The data in each column should all be the 

same type. For instance, do not mix text in a column with numbers, or numbers in a column with 

dates. 

 

 

3.1.2 Activate the AutoFilter 

Activate the AutoFilter by select Data Tab, then Filter. The AutoFilter arrows now appear to the 

right of each column heading. If you select an entire column instead of a single cell before clicking 

the Filter command, an AutoFilter arrow will appear only on the selected column, not on all 

columns of the data. 
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3.1.3 Start Filtering Data 

Suppose your worksheet contains customer sales data. Each customer entry includes information 

about the customer's location, products they purchase, purchase dates, and revenues and profits 

from each purchase. Perhaps you want to view sales activity only for those customers located in the 

West region. Excel can help you do this.  

 

 

3.1.4 Apply Additional Filters 

If you want to focus on even more specific information, you can filter again on another column, and 

then again on another column, and so on. You can click the arrow next to any heading in any 

column to apply a filter.  

 

3.1.5 Turn Off Filtering 

How you remove filters depends on how many filters you have applied, and from how many 

columns you wish to remove filters. 

 To remove a filter from one column, click the AutoFilter arrow next to that column, and then 

click All. That command will display the rows hidden by that filter.  

 To turn off AutoFilter, click select Data tab, then click Filter again. 
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3.2 Use Advanced Filtering Techniques 

Excel enables you to perform more intricate types of filtering. Two particularly useful types are: 

 Top 10 Filter  

 Custom Filtering. 

When you apply a filter to a column, the only filters available for other columns are the values 

visible in the currently filtered range. Only the first 1000 unique entries in a list appear when you 

click the arrow 

 

3.2.1 Finding the Top 10 (or Bottom 10) in a Column 

You can use the Top 10 filter on columns of numbers or dates. With Top 10 you can find either the 

top items or the bottom items (the smallest or largest numbers or dates). And you're not limited to 

finding the top 10 items or the bottom 10 items. You can choose how many items you want to see: 

only 1 or as many as 500. You can use Top 10 to find the highest-priced or lowest-priced products, 

to identify employees with the most recent hire dates, or to see the top or bottom student grades. 

To use Top 10 on a column of data, click on a data cell in the column and then click the column's 

AutoFilter arrow. Select (Top 10…) near the top of the drop down list. The Top 10 AutoFilter 

dialog box opens. In the dialog box, select either Top or Bottom. Then select a number. Finally, 

select either Items or Percent.  

You can filter columns in any order you choose. The filters are applied progressively, in the order 

you apply them. Each filter limits the data to which you can apply the next filter. 

 
 

3.2.1.1 Filter for the Smallest or Largest Number 

1. Click the arrow  in the column that contains the numbers, and click (Top 10...).  

2. In the box on the left, click Top, or Bottom.  

3. In the box in the middle, enter a number.  

4. In the box on the right, click Items. 

 

3.2.1.2 Filter for the Top or Bottom Numbers by Percent 

1. Click the arrow  in the column that contains the numbers, and click (Top 10...).  

2. In the box on the left, click Top or Bottom.  

3. In the box in the middle, enter a number.  

4. In the box on the right, click Percent.  
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3.2.2 Using Custom Filters 

When you filter by choosing from the AutoFilter drop-down list, you hide everything except your 

single choice. If you want to see more than one selection in a column, you can create custom filters.  

To create a custom filter, click (Custom…) near the top of the drop down list. The Custom 

AutoFilter dialog box opens. You can now enter two filtering requirements for the column of data.  

 

 

3.2.2.1 Filter a Range for Rows that Contain Specific Text 

1. Click the arrow  in the column that contains the numbers, and click (Custom).  

2. In the box on the left, click equals, or does not equal, contains, or does not contain.  

3. In the box on the right, enter the text you want. If you need to find text values that share some 

characters but not others, use a wildcard character.  

4. To add another criteria, click And or Or, and repeat the previous step.  

 

3.2.2.2 Filter for Blank or Nonblank Cells 

Click the arrow  in the column that contains the numbers, then click (Blanks) or (NonBlanks). 

The Blanks and NonBlanks options are available only if the column you want to filter contains a 

blank cell. 

 

3.2.2.3 Filter for Numbers Greater than or Less than Another Number 

1. Click the arrow  in the column that contains the numbers, and click (Custom).  

2. In the box on the left, click is greater than, is less than, is greater than or equal to, or is less 

than or equal to.  

3. In the box on the right, enter a number.  

4. To add another criteria, click And or Or, and repeat the previous step.  

 

3.2.2.4 Filter for a Number Equal to or Not Equal to Another Number 

1. Click the arrow  in the column that contains the numbers, and click (Custom).  

2. In the box on the left, click equals, or does not equal.  

3. In the box on the right, enter a number.  

4. To add another criteria, click And or Or, and repeat the previous step.  
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3.2.2.5 Filter for the beginning or end of a text string 

1. Click the arrow  in the column that contains the numbers, and click (Custom).  

2. In the box on the left, click begins with, or does not begin with, or ends with, or does not 

end with.  

3. In the box on the right, enter the text you want. If you need to find text values that share some 

characters but not others, use a wildcard character.  

4. To add another criteria, click And or Or, and repeat the previous step.  
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4. Sorting  

 

Excel provides numerous ways to sort worksheet ranges. You can sort by columns or rows, in 

ascending or descending order, and with capitalization considered or ignored. You can even define 

custom sorting sequences so that, for example, your company’s division names always appear in a 

particular order, regardless of their alphabetic sequence. 

 

4.1 Default Sort Orders 

After sorting a list of Excel figures, are some of the numbers not in the order you expect? A 

common reason for this problem is that some numbers may be formatted and stored as text instead 

of as numbers. When you sort data that includes values formatted and stored as text and as numbers, 

Excel sorts the text values separately from the number values. For example, the sales value for 

Tennis is formatted as text, and there were no sales for Soccer. When you sort this data by the Sales 

column in ascending order, you will get the following result: 

  

In an ascending sort, Microsoft Excel uses the following order. In a descending sort, this sort order 

is reversed except for blank cells, which are always placed last. 

Numbers     Numbers are sorted from the smallest negative number to the largest 

positive number. 

Dates     Dates are sorted from the earliest date to the latest date. 

Alphanumeric sort   When you sort alphanumeric text, Excel sorts left to right, character by 

character. For example, if a cell contains the text "A100," Excel places the 

cell after a cell that contains the entry "A1" and before a cell that contains 

the entry "A11." 

Text and text that includes numbers are sorted in the following order: 

0 1 2 3 4 5 6 7 8 9 (space) ! " # $ % & ( ) * , . / : ; ? @ [ \ ] ^ _ ` { | } ~ + < 

= > A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

Apostrophes (') and hyphens (-) are ignored, with one exception: If two 

text strings are the same except for a hyphen, the text with the hyphen is 

sorted last. 

Logical values In logical values, FALSE is placed before TRUE. 

Error values All error values are equal. 

Blanks     Blanks are always placed last. 
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4.2 Sorting on Column (by Row) 

You can sort on as many as three columns at once.  

1. Select a column of alphanumeric data in a range of cells, or make sure that the active cell is in 

a table column containing alphanumeric data.  

2. On the Data tab, in the Sort & Filter group, do one of the following: 

 To sort in ascending alphanumeric order, click  Sort A to Z. 

 To sort in descending alphanumeric order, click  Sort Z to A. 

3. Optionally, you can do a case-sensitive sort. 

 In the Sort dialog box, click Options.  

 In the Sort Options dialog box, select Case sensitive. 

 Click OK twice. 

4. To reapply a sort after you change the data, click a cell in the range or table, and then on the 

Data tab, in the Sort & Filter group, click Reapply. 

 

 

4.3 Sorting by Columns 

To sort by columns, follow these steps: 

1. Select a column of alphanumeric data in a range of cells, or make sure that the active cell is in 

a table column containing alphanumeric data.  

2. In the Sort dialog box, click Options.  

3. In the Sort Options dialog box, select Sort left to right. 

4. Click OK twice. 

5. Fill out the boxes and option buttons in the Sort dialog box, and click [OK]. 
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4.4 Sorting Months, Weekdays, or Custom Lists 

Excel normally sorts text in alphabetical order, but it can sort on the basis of any of its custom lists 

if you want it to. The program includes four custom lists by default  

 Sun, Mon, Tues, …  

 Sunday, Monday, Tuesday, …  

 Jan, Feb, Mar, …  

 January, February, March, …  

If you have a column consisting of these day or month labels, you can sort them in their proper 

chronological order. If you’ve created other custom lists, you can sort text fields in the order of 

those lists as well. 

 
 

To sort on the basis of a custom list, click Order in the Sort dialog box, and then select Custom 

List…. The four default custom lists will appear there, along with any others that you have created. 
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4.5 Sorting Cells that Contain Formulas 

You need to exercise caution when sorting cells that contain formulas with cell references. If you 

sort by row, references to other cells in the same row will be correct after the sort, but references to 

cells in other rows of the list will no longer be correct. 

Similarly, if you sort by column, references to other cells in the same columns will be correct after 

the sort, but references to cells in other columns will be broken. With either kind of sort, relative 

references to cells outside the list will be broken by the sort. 

To avoid the problems associated with sorting ranges containing formulas, observe the following 

rules: 

 In formulas that reference cells outside the sort range, use only absolute references. 

 When sorting by row, avoid formulas that reference cells in other rows. If you must use such 

formulas, reference cells by name, not by address. 

 When sorting by column, avoid formulas that reference cells in other columns. If you must use 

such formulas, reference cells by name, not by address. 
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5. Using Subtotals to Analyze a List 

 

Microsoft Excel can automatically calculate subtotal and grand total values in a list. When you 

insert automatic subtotals, Excel outlines the list so that you can display and hide the detail rows for 

each subtotal. 

To insert subtotals, you first sort your list so that the rows you want to subtotal are grouped together. 

You can then calculate subtotals for any column that contains numbers by selecting Data tab, and 

click Subtotal. 

 

 

5.1 How Subtotals are Calculated 

5.1.1 Subtotals     

Excel calculates subtotal values with a summary function, such as Sum or Average. You can display 

subtotals in a list with more than one type of calculation at a time. 

 

5.1.2 Grand Totals     

Grand total values are derived from detail data, not from the values in the subtotal rows. For 

example, if you use the Average summary function, the grand total row displays an average of all 

detail rows in the list, not an average of the values in the subtotal rows. 

 

5.1.3 Automatic Recalculation     

Excel recalculates subtotal and grand total values automatically as you edit the detail data. 
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5.2 Create Summary Reports    

1. Sort the column you wish to perform subtotal. 

2. Select Data tab, and then click Subtotals to popup the Subtotal dialog box 

3. In the At each change in box, click the column to subtotal.  

4. In the Use function box, click the summary function that you want to use to calculate the 

subtotals. In the example above, you would select Sum.  

5. In the Add subtotal to box, select the check box for each column that contains values that you 

want to subtotal. By default, Excel offers to subtotal the last column of your data. 

6. If you want an automatic page break following each subtotal, select the Page break between 

groups check box.  

7. To specify a summary row above the details row, clear the Summary below data check box. 

To specify a summary row below the details row, select the Summary below data check box. In 

the example above, you would clear the check box.  

8. Optionally, you can use the Subtotals command again by repeating steps one through seven to 

add more subtotals with different summary functions. To avoid overwriting the existing 

subtotals, clear the Replace current subtotals check box. 

9. Click [OK] to confirm. Excel inserts a new row at each change of column and calculates a 

subtotal. After you have the subtotals in, you will see small 1, 2, and 3 buttons appear below 

the name box. Click the 2 button to see just one line per account with the totals. Click the 3 

button to see all lines. 
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6. Validating Data Entry 

 

Data validation is an Excel feature that you can use to define restrictions on what data can or should 

be entered in a cell. You can configure data validation to prevent users from entering data that is not 

valid. If you prefer, you can allow users to enter invalid data but warn them when they try to type it 

in the cell. You can also provide messages to define what input you expect for the cell, and 

instructions to help users correct any errors. When data is entered that doesn't meet your 

requirements, Excel displays a message with instructions you provide.  

 

 

6.1 Types of data you can validate 

Excel lets you designate the following types of valid data for a cell: 

Numbers: Specify that the entry in a cell must be a whole number or a decimal 

number. You can set a minimum or maximum, exclude a certain number or 

range, or use a formula to calculate whether a number is valid. 

Dates and Times: Set a minimum or maximum, exclude certain dates or times, or use a 

formula to calculate whether a date or time is valid 

Length: Limit how many characters can be typed in a cell, or require a minimum 

number of characters. 

List of Values: Make a list of the choices for a cell — such as small, medium, large — and 

allow only those values in the cell. You can display a dropdown arrow 

when a user clicks the cell to make it easy to pick from your list. 
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6.2 Types of messages you can display 

For each cell you validate, you can display two different messages: one that appears before the user 

enters data, and one that appears after the user tries to enter data that doesn't meet your 

requirements. If users have the Office Assistant turned on, the Assistant displays the messages. 

  

 

6.2.1 Input Message 

This type of message appears as soon as a user clicks the validated cell. You can use it to provide 

instructions about the type of data you want entered in the cell. 

 

6.2.2 Error Alert 

This type of message appears only when the user types data that isn't valid and presses [Enter]. You 

can choose from three types of error messages. If you don't specify any messages, Excel flags 

whether the data a user enters is valid so that you can check for it later, but does not notify the user 

when an entry is invalid 

Information Message: This message does not prevent entry of invalid data. In addition to the 

text you provide, it has an information icon, an OK button, which 

enters the invalid data in the cell, and a Cancel button, which restores 

the previous value to the cell. 

Warning Message: This message does not prevent entry of invalid data. It has the text you 

provide, a warning icon, and three buttons: Yes enters the invalid data 

in the cell, No returns to the cell for further editing, and Cancel restores 

the previous value to the cell. 

Stop Message: This message won't allow invalid data to be entered. It has text you 

provide, a stop icon, and two buttons: Retry returns to the cell for 

further editing, and Cancel restores the previous value to the cell. Note 

that this message isn't intended as a security measure: although users 

can't enter invalid data by typing and pressing [Enter], they can 

circumvent the validation by copying and pasting or filling data in the 

cell.  
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6.3 Setting up Data Validation 

Once you know what validation you want to use on a worksheet, you can use select the Data tab, 

and then select Data Validation to set it up. Here's a general overview of the process: 

1. Set up your worksheet – Start by entering the data and formulas on your worksheet. If you're 

using a list of valid choices, enter and name your list.  

2. Define the settings for a cell – Beginning with the first cell you want to validate, use the Data 

Validation dialog box to designate the type of validation you want, an input message if you 

want one, and an error message if you want one.  

3. Set up validation for other cells – You can often save time by copying the validation settings 

from the first cell to other cells and then modifying the settings.  

4. Test your validation rules – Try entering both valid and invalid data in the cells to make sure 

your settings are working as you intended and your messages are appearing when you expect. 

Use the Validation command to make any changes to the settings. If you make changes to the 

validation in one cell, you can automatically apply your changes to all other cells that have the 

same settings.  

5. Set up your lists of valid choices – If you used a list of valid choices and don't want users to 

be able to find and change the list, you can put the list on another worksheet, set up the 

validation, hide the worksheet that contains the list, and then help protect the workbook with a 

password. The workbook password will help guard the worksheet that contains the list from 

others.  

6. Apply protection, if desired – If you're planning to protect the worksheet or workbook, do 

that after you're finished setting up validation. Make sure you unlock any validated cells before 

protecting the worksheet, otherwise users won't be able to type in the cells.  

7. Share the workbook, if desired – If you're planning to share the workbook, do that after 

you're finished setting up validation and protection. After you share a workbook, you won't be 

able to change the validation settings unless you stop sharing, but Excel will continue to 

validate the cells you've designated while the workbook is shared.  

8. Check the results for invalid data – After users enter data in the worksheet, you can check 

for invalid data. 

 

6.4 Entering data in validated cells 

Here's what the process of entering data is like for users. You can use input and error messages to 

provide the instructions users need to understand how you've set up the worksheet to ensure correct 

data.  

 

6.4.1 Viewing your input message    

When a user clicks a validated cell or uses the arrow keys to move into the cell, your input message 

appears either in an Assistant balloon or a separate message box. If you provided a dropdown list 

for the cell, the dropdown arrow appears to the right of the cell. 
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6.4.2 Typing data    

As the user types data or clicks the dropdown arrow to select a value from your list, the input 

message stays on the screen (the dropdown list may cover part of your message). 

 

6.4.3 Entering valid data    

If the user types valid data and presses [Enter], the data is entered in the cell and nothing special 

happens. 

 

6.4.4 Entering invalid data 

If the user types data that doesn't meet your criteria, and you specified an error message for invalid 

data, your message appears either in an Assistant balloon or a separate message window. The user 

can then read the message and decide what to do.  

 For an information message, the user can click [OK] to enter the invalid data, or click [Cancel] 

to start over.  

 For a warning message, the user can click [Yes] to enter the invalid data, [No] to edit the cell 

some more, or [Cancel] to start over.  

 For a stop message, the user can't enter the invalid data, and can either click [Retry] to edit the 

cell or [Cancel] to start over.  

If you don't provide messages, entering data in validated cells is the same for users as regular Excel 

data entry. However, Excel does flag any cells that have invalid entries so you can easily find those 

entries. 

 

6.5 Checking a Worksheet for Invalid Entries 

When you receive worksheets back from users who may have entered invalid data, you can have 

Excel display red circles around any data that didn't meet your criteria, making it easy to scan the 

worksheet for errors. Use the [Circle Invalid Data] and [Clear Validation Circles] buttons on the 

Auditing toolbar for this purpose. When you correct the data within the cell, the circle disappears. 
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7. Consolidating Data in Multiple Worksheets 

 

To summarize and report results from multiple worksheets, you can consolidate data from each 

worksheet into a master worksheet. The worksheets can be in the same workbook or other 

workbooks. When you consolidate data, you are assembling data so you can more easily update and 

aggregate it on a regular or ad hoc basis.  

 

For example, if you have a worksheet of expense figures for each of your regional offices, you 

might use a consolidation to roll up these figures into a corporate expense worksheet. This master 

worksheet might contain sales totals and averages, current inventory levels, and highest selling 

products for the entire enterprise. 

 

 

To consolidate data, you use the Data tab, and then Consolidate to display the Consolidate dialog 

box.  
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You can use this dialog box in several ways to consolidate your data:  

Position Use this approach when the data in all worksheets is arranged in identical order 

and location. 

Category  Use this approach when each worksheet organizes the data differently, but has 

the same row and column labels, which you can use to match the data. 

3-D Formulas Use this approach when the worksheets do not have a consistent pattern you can 

rely on. You can create formulas that refer to cells in each range of data that 

you're combining. Formulas that refer to cells on multiple worksheets are called 

3-D formulas 

 

7.1 Consolidate by Position or Category 

Consolidate by position when the data in all source areas is arranged in identical order and location; 

for example, if you have data from a series of worksheets that were created from the same template, 

you can consolidate the data by position. 

Consolidate by category when you want to summarize a set of worksheets that have the same row 

and column labels but organize the data differently. This method combines data that has matching 

labels from each worksheet. 

You can set up the consolidation to update automatically when the source data changes, but you 

won't be able to change which cells and ranges are included in the consolidation. Or you can update 

the consolidation manually, allowing you to change the included cells and ranges. 

1. Set up the data to be consolidated. 

2. Click the upper-left cell of the area where you want the consolidated data to appear.  

3. Select Data tab, and then select Consolidate to popup the Consolidate dialog box. 

4. In the Function box, click the summary function you want Excel to use to consolidate the data.  

5. Click the Reference box, click the sheet tab of the first range to consolidate, type the name 

you gave the range, and then click [Add]. Repeat this step for each range.  

6. If you want to update the consolidation table automatically whenever data in any of the source 

ranges changes, and you're sure you won't want to include different or additional ranges in the 

consolidation later on, select the Create links to source data check box.  

7. If you're consolidating by position, leave the boxes under Use labels in blank. Excel does not 

copy the row or column labels in the source ranges to the consolidation. If you want labels for 

the consolidated data, copy them from one of the source ranges or enter them manually.  

8. If you're consolidating by category, select the check boxes under Use labels in that indicate 

where the labels are located in the source ranges: either the top row, the left column, or both. 

Any labels that don't match up with labels in the other source areas result in separate rows or 

columns in the consolidation. 
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7.2 Consolidate by Using 3-D Formulas 

When you use 3-D references in formulas, there are no restrictions on the layout of the separate 

ranges of data. You can change the consolidation any way you need to. The consolidation updates 

automatically when the data in the source ranges changes. 

 

7.2.1 Use formulas to combine data    

In the following example, the formula in cell A2 adds three numbers that are located in different 

positions on three different worksheets. 

 

 

7.2.2 Add data to a consolidation with 3-D references    

When all of your source worksheets have the same layout, you can use a range of sheet names in 

3-D formulas. To add another worksheet to the consolidation, just move the sheet into the range 

your formula refers to. 

 

 

7.2.3 Step to create 3-D Formulas Consolidation 

1. On the consolidation worksheet, copy or enter the labels you want for the consolidated data.  

2. Click a cell that you want to contain consolidated data.  

3. Type a formula that includes references to the source cells on each worksheet that contains 

data you want to consolidate. For example, to combine the data in cell B3 from worksheets 

Sheet 2 through Sheet 7 inclusive, you could type =SUM(Sheet2:Sheet7!B3). If the data to 

consolidate is in different cells on different worksheets, enter a formula such as this: 

=SUM(Sheet3!B4, Sheet4!A7, Sheet5!C5). To enter a reference such as Sheet3!B4 in a 

formula without typing, type the formula up to the point where you need the reference, click 

the worksheet tab, and then click the cell. 

 

 

 

 

  


